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Practical No. 1

Object: Introduction & Overview of MS Project

Microsoft Project is really a computer database that uses two main tables of data to keep track ofyour project.
Project uses one table to store information about the tasks of your project and the other for resource information.
By using the many views available in Project, you can displayyour project data from these tables in many ways.

Tasks

This table is comprised of over 240 columns (or fields) which contain all sorts of information about thetasks
such as scheduled start, scheduled finish, name, duration, cost, and the like. Some of these fields require you to
enter data, while others are calculated and filled by Microsoft Project for you.

ID Name Duration Start Finish Fixed Cost etc...
8 Erect fencing 2 days 1/2/2013 | 3/2/2013 | No $500
Resources

This table contains over 200 fields (or columns).

ID Name Initials | Group Max Standard Overtime | etc...
: Units Rate ’ Rate
3 Builder FG Contractor | 4 | $55.00/h $75.00/h

The two tables are joined together by assigning resources to tasks.

Views .
To help you see, or view, youf data, Microsoft Project adopts techniques used in spread sheets,databases, and
graphics packages. ‘
For example, you can see your task or resource table in sheets on the screen. Sheets are like spread sheet
programs where data is presented in rows and columns. In fact, many of the operationsused in spreadsheets,
such as widening columns, deleting data, selecting cells, and the like, are alsofound in Micresaft Project.

You can also see, or view, your data in forms. These forms are like a form view that you receivefor 'déta
entry screens in database programs. Forms allow you to add or edit data and you can usuallycycle through
the cards as you would in a normal database.

If you wish to see your data graphically you can view it as a Gantt Chart or Network Diagram.In addition
you have a variety of other graphs for displaying resources.

?

§iu)
4 ndl Wed 21/08/13/
5 IRigger : 2,700h od od Wed 21/08/13 Tue 1211112
6 Bailermaker 2,700h od| ad[ Wed 208131 | Tue 12/11/13
7 Weslder 2,250h i -od odj Wed 2108/13 Tue 12/11/13
1 10 iLabourer 2,700h ! od od! Wed 21,0813, Tue 12/11/13]
| 1 joreer 900h od ] Wed 21/08/13 Tue 12/11/13,
18 Hl_qh Jb Crane 450h l nd od Wed 2108/13 Tue 12/11/13'
1 20 lubiy 450h [ od| od]  wedzipe/3l - Tue 11113
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The Work Area

The work area occupies the
largest part of the screen and

Create archbectursi ciane

contains the data associated
with your project. The key
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The Ribbon

When you need to do something with the data in the work area, such as format it, colour it, analyse it,move
it, copy it, change the view of it and much more, you’ll find all of the relevant commands on the Ribbon.
The Ribbon has commands organised thematically using a series of tabs across the top.
Commands on each tab are further organised into groups of like-commands. It’s not too hard to get the hang
of where a command can be found. Remember, a project is simply a view of task and resource data
— hey, have a look at the Ribbon and you’ll find a Tasks and a Resources tab! So whatever you need todo
with tasks can be found on the Tasks tab, and anything you want to do with resources can be found on the

Resources tab.

" eroferk”
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Hlave -

Backstage

When you want to do something with

the data in your work area, such as
save it so that you can access it again
later, print it, share it with a
colleague,send it to your boss, protect
it from prying eyes, or whatever, you
will need to access the Microsoft
Office Backstage area of Microsoft
Project. The Backstage is accessed
using the File tab on the Ribbon.
Rather than offering you commands

Print

[ copen i

on a Ribbon, Backstage occupies the
entire screen and has a series of
options down the left side. Here the
Print option is active, and that is why
you can see a preview of the work

area and a series of print-related
options on the right side of the
Backstage.

Y
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When you click on the arrow for one
Fofmiat - ofthe View commands you’ll receive a
 Bhsor~ 2B Highighy menu of further views available to
Viworme ~ you.All of the menus feature the More
& “Views command which displays the
‘More Views dialog box which lists all
of the standard views available to you
in Mlcrosoft Project. :

e Chat Yoots: i

[

4] E = rc- ”3 Resaurce Usage » :

= ﬁ e i 3 Resource Sheet v |
e

1 pymne, - ’;a Other View:

/1| Gantt Chart

i Tracking Gantt

i Reset to Default
Save View...

: More VIewx

Built-In Project Views

Microsoft Project contains 27 different built-in views for you. Seven of these views are avallable from the
Task Views and Resource Views groupings on the View tab, while the full 27 are available fromthe More
Views dialog box. Here’s a list of the 27 views — the ones marked with a (T) or (R) are accessible directly
from the View tab of the Ribbon.

Bar Rollup Multilee Baselines Gantt Task Details Form
Calendar (T) Network Diaéram (T) Task Entry
Descriptive Network Relationship Diagram Task Form
Diagram
Detail Gantt Resource Allocation Task Name Form
Gantt Chart (T) Resource Form ' Task Sheet
Gantt with Timeline Resource Graph Task Usdge M
Levelling Gantt Resource Name Form Team Planner (R)
Milestone Date Rollup Resource Sheet (R) : Timeline
Milestone Rollup : Resource Usage (R) Tracking Gantt
WORKING WITH VIEWS

A view is the way we look at the project and the data it contains. In order to work with your project
successfully, you will need to learn how to operate and manipulate the many different views. The main way to

change the view of your project isthrough the commands on the View tab or throughthe Quick Views buttons
at the bottom right of thescreen. :

e e ]

Page 9
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USING THE RIBBON

The Ribbon is the command centre for MicrosoftProject. It provides a series of commands organized into groups
and placed on relevant tabs. Tabs are activated by clicking on their name to display the command groups.
Commandsare activated by clicking on a button, tool or galleryoption. Everything you could possnbly want to do
in Project will be found somewhere on this Ribbon

Try This Yourself:

. ) ) w PReR ‘f Mark on Track ~ ¢ [ Ghnpm ~
Before starting this exercise L Prereion o =
ensure that Project has

started...

&2 ey 3 B> Leveling Options
3 §§,’" i @

i B wm, Ye # 2, Clear Leveing
Leved Level  Level

Sz!r tea luwulu Al ih"mo:euluumlon
. Lovel ii

1 Examine the various
groups on the Task tab

The group names appear at
the bottom of the Ribbon...

2 Click on the Resource fab

The commands on this tab
are used to work with
resources. Many will not be
available because there are
no resources in the blank
project on the screen. You
can never be too sure what
you'll get when you click on
a command...

| fa

attute | Add Jotocuation okes Detadls | Laval  Level
?tsauzns | Reseourees crion Resource

. 8! Shace Hesaurces...
o, Befrash Revourae Pool
M.

%- Lptiite Resouiree Po

Assign  Re500)
. Resaurces i Pox

Pisperties

Click on Resource Poof in
the Assignments group to
display a menu

il Resources for Projects’:

@ Use gwri resources | ] :
‘ . HES t‘\mermxtes&maut&wwepemwamm ;

Click on Shére Resources | e R

to display the Share : mmnﬂctmcalendarwumr:emfumﬂm Ly

Resources dialog box VR

Click on [Cancel] to pop
the box away

Click on the other tabs and
spend some time examining
the groups and commands
they contain

7 Click on the Task tab

N hn B~ W

THE PROJECT WORK AREA

The main part of the Microsoft Project screen ismade up of the work area where your project data is displayed. Remember,
Project is really just two tables of data — tasks and resources The work area shows you different aspects and sometimes

combined views of this data. For example, you can view your tasks and the resources assigned to them.

The View Tab

The View tab on the Ribbon (B
provides you with access to the
views for your project’s data.

Task Resource Project l View “ meak

'8 Resource Usage + 2 l Soit v .25 [No Highlight] + Timescale:
= :&Resource Sheat v i

¥ Usage v [~ Planner~ £ Other Views ¥
 Yask Views i . Rezource Views E : Tata

Notice, there is a Task Views 10utine v 7 [NoFitey + Days

. Tables » No G .
grouping and a Resource svies 2o roupl

Page 8
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Task Tables
There are 17 pre-defined tables for tasks as follows:
Baseline Earned Value
Constraint Dates- Earned Value Cost Indicators
Cost Earned Value Schedule Indicators
Delay Entry

Resource Tables

There are 10 pre-defined tables for resources as follows:

Cost Entry — Material Resources
Earned Value Entry — Work Resources
Entry Export

Exercise:

Department of Metallurgical Engineering
B e ST

- Export

Hyperlink
Rollup Table
Schedule

Hyperlink

Summary

Summary
Tracking
Usage
Variance
Work

Usage
Work

Consider a company and develop project process in detail with predecessors and put it in Ms-Project table.

Page 11
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THE MICROSOFT PROJECT
SCREEN '

The Microsoft Project screen
will vary depending upon the
view, table, and filter that is
currently active. However, you
will need to become familiar
with the basic components of
the screen as shown below.
Understanding the layout of the
screen, and its components and
terminology will help you in
using Microsoft Project.

s

pang —
indicator

Sheet
view

. Create archiccmrel plans Mon, amam A«chiea(braﬁswwﬁzou%

(| St pians for spproval ‘ ArchiectorH)
Order matarials "\DraftspersonBuiking Clerk
Planning Completed

=t Site Works

Erect fencing 7 Ho Barrier Fencing
Erect site buildings 4 days! Wed 10/07/13 1 Supervisor, Carpenter{400%] Labourer{800%}
Clear and level site 3 wksi" Tue 16/0TH3! Supervisor,Driver{200%],Grader{200%]

Ganit
chanr

Scheduling mode Status bar Quick view buttons

Ribbon _

Active pane
indicator

Sheet view:
Scheduling mode

Stafus bar
Quick view buttons

Gantt chart

The Rtbbon dlsplays the commands requn'ed to use Mlcrosoft Pro_]ect. It is made up of
tabs (File, Task, Resource, etc) which each contam groups of commands orgamsed mto
logical order, . ¢ o i :

The active pane mdtcator isa vertlcal bar w1th a dark colounng that runs down the left
side of a screen (or a view). The one above contains the words Gantt Chart so that you
know you have a Gantt Chart as the active view. You can actually have two different
views open by splitting the screen — only one view, however, can be active because
things like the commands on the Ribbon are controlled by what you are viewing. The
indicator shows which view is currently active.

3 l Your prolect’s tasks and resources can be seen as a table much llke a spreadsheet In
.. Microsoft Project thls is referred to as a sheet view. : o

Your project can be scheduled manually (the default) or automatlcally This (very
important) indicator tells you which mode is currently applicable.

‘Waich this space ~ it tells you what Microsoft Project is currently up to.

There are many ways to change the view of the screen. These four buttons provide

quick access to the four most common views saving you the hassle of locating the
commands to do this on the Ribbon.

. The Gantt Chart is the world’s most favourite view of a project. It shows your project’s

tasks as a series.of timelines. It is the default view of Microsoft Project when it is first
started and, in reality, will most likely be the one you use most.

HOW MICROSOFT PROJECT WORKS

For a novice user the Microsoft Project screen can seem intimidating. However, you’ll soon see that it is
made up of only three key areas. The data you type is placed in the work area. The data here can be
manipulated and changed using commands on the Ribbon. The data is saved in a project file which is
controlledthrough commands on the Backstage.

Page 6
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Try This Yourself:

Before starting this
exercise ensure that
Microsoft Project has
started...

l Click on the View tab andspend
: a few moments studying the
options in theTask Views and
Resource Views
groupings

2 Click on Task Usage inTask
Views to see the work

allocations on the
screen

‘ 3 Click on Calendar in Task
Views to see thescreen laid
outasa

There is an obvious lack of data presented on this screen!
calendar Don’tworry too much at this stage about what the view is

all about. Allwe are doing at this stage is examining the
View commands to see how they work and what they
offer.

4 Click on Other Views in Task
Views to display a menu and
click on TaskForm

5 Click on Resource Sheet
in Resource Views tosee a
spreadsheet-like
view of the resources

6 Click on Gantt Chart in Task
M Views to return to the Gantt
Chart view

UNDERSTANDING SHEET VIEWS

Sheet views of data are common to database and spreadsheet applications. Microsoft Project also uses sheet
views where data is presented in rows and columns. In Project there are literally dozens of columns (called
fields) for tasks and similarly for resources. To make it easier to work with these columns, oops fields, they
have been organized into tables. '

About Tables

Since there are literally dozens of fields for both Tasks and Resources, Microsoft Project organizesthese in
specialized groupings into tables. For example, fields for tasks associated with costs are organized into a
Cost table, fields that are commonly used for data entry are organized into an Entry table, and so on.

i Basetne
Crvetrant Datas
Gost
Celay
Eaived Value
i Ewrad valve o3t tncicatens
| ARSI Rt Lttt
1 !wn'arf“‘
H o
Tk Table #
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Practical No. 3

Object: Resource selection, allocation & optimization

Once a project schedule is created, it will usually have to be altered to avoid over allocating a particular resource
(for instance, a subcontractor), which will cause the schedule to be held up. Assignments are the last step of data
to enter into the project schedule and they reflect who works on a task. Knowing how to allocate resources will
help keep.you in control of your project from start to finish. By assigning resources to tasks, you can make sure
that you have enough resources to accomplish the tasks in your project. You assign people and equipment in the
same way. You assign resources to tasks to clarify responsibility for getting those tasks done. Assigning resources
also helps, you determine how long it will take for a task to get done, and, if you track costs, how much the task
will cost.
You should assign resources to tasks when your goal is to:

- Track the amount of work done by the people and equipment assigned to the tasks.

- Ensure high accountability and understanding of the project — responsibilities are clear, which decreases
the risk of tasks being overlooked.

- Have greater flexibility in planning when and how long tasks take to complete

- Monitor resources with too little or too much work assigned.

- Keep track of resource costs.

Task Name %Resource Mames  Duration

Step by step on how to assign resources to tasks: . ‘ 5
: ; ; ; task 1 1 day?

1. Assign resource using Resource Names column in the - tacka TR i L
Gantt Chart view. f-{-;;i new resource 1 §
If Resource Name column is not present in your table, right oo oo *3 new resoutce 2 §
click on grid columns and click on insert column then select .- . .- ... [ newresourced |
"Resource Names". , . [ 18 New User |
§

1. You can import Team Members using the Assign
Team Members dialog (menu Team - Assign - Team
Member) or by adding them from Gantt Chart.

f‘}"f User Name
] @ Add Team Member

2. When you open the Resource Names drop-down menu,
you will get a list of all resources in your project-and
the Team Members (marked with an icon). Note that
all the Team Members are visible in this list (imported
or not). Selecting any Team Member in this list will

. import it to the current project (only once). If you want
to add a new Team Member, click Add Team Member  siscer
button and the following dialog will be opened. ot

Add Individual -
Team Member

The pgaron you sve adding needs o hava g volid z-mal addssss,

Avaitabie Bditor Subscriptions: 9

After clicking on the Add Team Member button, John will be
added as a Team Member

2. Assign Resource using Task Information dialog

Open Task Information dialog and in Resource tab write or select the resource/resources you want to add. bet the
resource units or the number of items.

Page 14
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Practical No. 4

~ Object: Understanding of Work Breakdown structure and how we develop it in MS Project?

A Work Breakdown Structure (WBS) is a deliverable-oriented hierarchical decomposition of the work to be
executed by the project team to accomplish the project objectives and create the required deliverables. A WBS is
the comerstone of effective project planning, execution,. controlling, monitoring, and reporting. All the work
contained within the WBS is to be identified, estimated, scheduled, and budgeted.

Work Breakdown Structure Diagram

The Work Breakdown Structure (WBS) is developed to establish a common understanding of project scope. It is a
hierarchical description of the work that must be done to complete the deliverables of a project. Each descending
level in the WBS represents an increasingly detailed description of the project deliverables.

The first two levels of the WBS (the root node and Level 2) define a set of planned outcomes that collectively and
exclusively represent 100% of the project scope. At each subsequent level, the children of a parent node

collectively and exclusively represent 100% of the scope of their parent node. Here is a Work Breakdown
Structure example:

Blectricat Contrackar tabor Crew + i e Masonry Contractor
. Work 1.80% wiork 18.20% L vork 1620% |
Budget  $25000 i Budget  $37000 ! Budget  $62000

Elements

E
Plambing Contractor G.C. Superintendent

Patating Contractor
Work 33.80% ok 58% Work I820% ¢

Budget  $61,000 ~ Budget $9,000  Budget  $21500

Quality of a Work Breakdown Structures ‘
A well-designed WBS describes planned outcomes instead of planned actions. Outcomes are the desired ends
of the project, such as a product, result, or service, and can be predicted accurately. Actions, on the other hand,
may be difficult to predict accurately. A well-designed WBS makes it easy to assign elements of the WBS to
any project activity. A good WBS should exhibit the following characteristics:
¢ Definable—can be described and easily understood by project participants.
e Manageable—a meaningful unit of work where specific responsibility and authority can be assigned to
a responsible individual. '
¢ Estimateable—duration can be estimated in time required to complete, and cost can be estimated in
resources required to complete.
e Independent—minimum interface with or dependence on other ongoing elements (i.e., assignable to a
single control account, and clearly distinguishable from other work packages).
o Integratable—integrates with other project work elements and with higher level cost estimates and
schedules to include the entire project.
e Measurable—can be used to measure progress; has start and completion dates and measurable interim
milestones.

¢ Adaptable—sufficiently flexible so the addition/elimination of work scope can be readily
accommodated in the WBS framework.

Page 18
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Define resource type using Type column - select Material type.

- Then, go to Gantt Chart view, locate in Resource Names column the desired material resource.

mwwm swdmt X

0. fromated Standad

Provered Standard

1l?!DmiQd mdad R
wmud sm-iard"_

oo R

3 POp Stantard

Pronytest Stwoted

50 peorated: 5; dard__

Note: If you have a single task with a lot of people assigned, making changes in the Resource Names column

may not work.

For tasks where you need a lot of resources assigned, it's best to make your assignments, and make changes to
those assignments, in the Task Information dialog box. On the Resources tab, you can assign a longer list of

resources to the task.

Gereral | Predecessors Resourcas | advanced | Hotes.-| Costom Fieids |

Matfimton |

lame: Team meeting and diccustion sth potners 3. Derstiow s
Resgurces: |
: =
Rescurce Name Assignment Owner Urtits Coat i
""""" Electfic Contractat Mana gement 100% 140,00
:Elevator Contractor wanagemem 100% $120.00

100%
0%
100%

‘Plumbing Contractar Mansgement

100% 5[40 4
iRoafing ContractorManagement 100% $140,00
ictesl Erection Contractor Managament 150% $120.95

With regard to resource assignment, there are two types of scheduling generally met in project management:
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1. Fixed deadline and unlimited resources - it is the case when adhering to a strict deadline is mandatory, and the
project manager must do whatever it takes to meet the deadline;

2. Limited resources - when the resources are limited but the deadline is flexible; in this situation the PM is not
allowed to hire new persons; overallocation is allowed, corresponding to resources working more than 8 hours a
day (extra-working hours), and this degenerates in a more flexible deadline.

Project Plan 365 implements the two scheduling policies above regarding resource assignment and, also, a third
one.

In the first scenario described above, the PM estimates the maximum duration for each task such that the whole -
project will meet the deadline. Then, it assigns all the resources necessary to accomplish the activity in the given
period. If you are in this situation while planning, then Project Plan 365 must use the "Fixed Duration" policy.

In the second scenario, instead estimating the duration of the task, you should estimate the total amount of work
required to accomplish the task (that is the number of hours required by a single person to do the task). After
setting the work field, you assign the resources you have and the duration of the task will be computed based on
the assignment. In this situation, Project Plan 365 must use "Fixed Units" policy.

The current section describes resource assignment under "Fixed Units".

You can assign one resource, a part-time resource, multiple resources, or multiple units of the same resource to a
task. Project Plan 365 displays the percentage of time a resource is assigned to a task, and the number of multiple
resources assigned to the task, next to the resource name by the task bar on the Gantt Chart. You can remove a
resource from a task at any time. If you want to remove a resource from a task, simply delete the resource name
values from the Resource Names cell corresponding to that task. Use the Undo option if you want to restore the’
assignment.

When assigning a resource of type work, this may work full time at a given task, or part time. You indicate the
percent of the work day dedicated by the resouree to the task in units: 1 unit (or 100%) is equivalent to full time.
Project Plan 365 allows resource assignments with 0% units and resource assignments that exceed 100% units. A
resource assignment with 50% units corresponds to 4 hrs/day, while a resource assignment with 200% units
corresponds to 16 hrs/day. If two resources are allocated to the same task, the total number of Resource Units
assigned to that task is 250% or simply 2.5.

The first time you add resources to a task, you will notice that a value for the work field is computed for that task.
The formula used to compute work is: task work = task duration x assignment units. If you edit again the
assignment (i.e. the Resources names field), you will see that duration gets modified while the value of work is
kept constant. If you modify the total amount of work required for the task and edit the work field, the duration is
recomputed. Changes in duration draw updates on work. This is the scheduling behavior at resource assignment
under the "Fixed Units" policy.

Exercise:

Develop Resource sheet by adding material and human resource and allocate these resources to your project with
costing.

Page 17
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Task Infarmation X 5

| Gereral | Predecessors  Resources | advanced | Notes | custiom Fieids |-

Name: %N"S"désﬁi'l"bnnﬂ and insurance dacuments } Dujrailajn:ﬁ?a?s

, ..‘,.:‘.v_”é
s Cast ] ; ]
G.C. Project Management . 100% ) 181,12000

+ {@.C: Ganeral Management 25% $3211.00

Resources:”

Reaource Name ! Assignment Owier

Carpet Contractor
iConrrete

- {Dryevall Contractor
- Electric Contractor

Electric Contractor Managément

~iElevator Cantractor

Elevatar Contractor Managenieint
IG.C Accounting
G.C Procurement
G.C Scheduler
THG.C. Concrete Craw
3.G.C. Finish Carpenter Crew
4G.C. General Managerent
. %G Labor Crew
13 Project Management

; Rough Carpanter Cred
G Superintendent
;4 G.C Survey Crew

3. Assign Resource using Assign resources dialog.

Select the desired task in the grid then go to menu Team - Assign - Resource. In Assign Resource dialog, select
the desired resource and click on Assign button. Set the resource units or the number of items.

*dm,

Assign resousees X

Task: Submit bond and instrsnce decuments

f - . .4

iResource Name Linits Cost e Ausign !

G € General Monagement  (95% 3000 S

+ GC ProjectManagement 100% $30.00 N
|G.C. Procurement ' . ) }

| 'G.C. Scheduler i
| G.C Accounting i
i i
H i
i 3

{G.C. Superintendent
{__IG.C Survey Crew

4. Assign resource type Material.

First add resources like equipment and materials using Resource Sheet view.
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Gantt Chart View

. The default view in MS Project is the Gantt Chart view. In it, users can see task information as both text and
bar graphics because the window is split into two sections. On the left side columns (containing Microsoft
Project fields) are shown. You can use these columns-to modify task names, durations, start and finish dates,
and other information. Other fields may include Task Number, Indicators, Predecessors, Resource Names,
planned and actual costs. The right side of this view shows the Gantt chart. This chart is made up of bars that
graphically display task durations and start and finish dates on a timescale. This sequence of bars shows the
order in which tasks are scheduled to occur. Gantt Chart view is useful when:

Entering tasks and task durations.

Establishing sequential relationships between your tasks.

This view allows you to see how changing task duration affects the start and finish dates of other
tasks and the project finish date.

Designating resources to a task. 1-5

You want to watch how much of each task is complete and follow the progress of your project by
comparing actual start and finish dates with the planned dates.

Gantt Chart views can be customized to meet your needs. Your changes to the view are saved with the
project file. Some things you can change in the Gantt Chart view, are:

The number of columns and the information that is displayed. For example, you can display, hide, or
change the appearance of nonworking time.

The formatting of fonts. For example, you can apply bold to an important finish date or increase the
size of column titles. '

How units of time are shown.

The formatting of the Gantt bars. You can use this option to emphasize specific conditions in the
schedule. For example, you could change the color of a critical task.

How gridlines are displayed. You can use this option to enhance the readability or clarity of the
Gantt Chart. For example, you can specify different line patterns and colors for column, row, and
title gridlines.

Draw your own labels or figures to the Gantt Chart.

Whether or not subtasks are displayed.

" wesmrne

e

Exercise:

Assign Days to all the process and develop Gantt Chart in MS-Project
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Practical No. 2

Object: Introduction & Development of Gantt Chart

The Gantt Chart view is used to display tasksand durations as bars plotted on a time scale. It provides an
overview of the project, plus thecapacity to enter or edit task information. It is the default view in Microsoft
Project and themost common view. It also contains a few usefulfeatures for displaying your data.

Try This Yourself:
5QUrCE 17 T View i
. P E " 3 ﬂﬂuouﬂ:e Usage v "} l, Sot - F- ) tNo Rl‘nhliqt‘uﬂ‘ - ﬁme:ca.l?." o
Before starting this , : outine = 7 ioPitel Sk
exercise ensure that - _ 41N Grocy
Microsoft Project has sk e Resprss Viewr sl e,

started...

1 Click on the right arrow []
of the horizontal scroll barin
the left pane to scroll the
sheet view and see different
columns

2 . Click on the left arrow [4]
until the first field is back
in view
3 Click on the right arrow [*]

of the horizontal scroll barin
the right pane and notice

" (Q zoom >~

2
¢ Sheet v ; : » &8 entice Project

3

X A Tows v i} Tabsles + @"‘[Na Grougl  ~ Y Ctaded T |
. how the timeline scrolls w N x;;q o ‘ |
Click and hold the mouse
4 pointer on the grey buttonon
the right scroll bar to reveal m——— : FrEEy YT
the date that the timeline is I

currently viewing

Hold down the left mouse
button on the line that

5 divides the table on the left
from the timescale onthe
right and drag it to theright
to see more Of the sheet . ¥ rimnule‘:‘ ¢l 2aom ~ - £ vasline '

view d Entire Praject
B Seheded Wihs

Double-click on the vertical
line to precisely align it to
6 the nearest field
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Different Moules of SAP ERP

SAP MM (Material Management) Module:

Features of SAP MM The features of a SAP MM system are as follows:
» SAP MM is one of the modules of SAP that deals with material management and inventory management.
¢ Material Management as a process ensures no shortage of materials or any gaps in the supply chain process of
the organization, SAP MM speeds up the procurement and material management activities, making the business
run smoothly with complete time and cost efficiency. '
o It deals with managing the materials (products and/or services) and resources of an organization with the aim of
accelerating productivity and reducing costs. At the same time, SAP MM is quite versatile to accommodate
changes that are frequent in any business erivironment.
¢ It deals with the Procurement Process, Master Data (Material & Vendor Master), Account Determination &
Valuation of Material, Inventory Management, Invoice Verification, Material Requirement Planning, etc.

e Master Data

-«  Purchasing

e Inventory
Master Data
Materials master data creation ‘
e It consists of Description, allocation of code, Unit to measure, Category, Unit weight and Gross weight
e Storage area reference
e Re-ordering level

Purchasing
s Creation of purchase requisition
* Conversion of purchase requisition in to purchase order
» Quotation review, comparison & finalization.
e  Purchase order creation, release and edit

Pricing ‘
o Creation procedure to arrive at landed price
e Price calculation and conditions i.e. discount, tax, rounding off, plus / minus tolerance

Inventory
e Overview of inventory management
* Rule for Goods receipt
* Location of inventory
o Issue of goods
Transfer posting of goods
» Physical verification of inventory
» Special stock and special procurement

Page 27
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Guidelines tor Developing Work Breakdown Structure
The development of Work Breakdown Structure involves subdividing the major project activities or sub-
activities into smaller, more manageable activities until the activities are defined in sufficient detail to support
the management and development of project works. The items at the lowest level of a branch are known as
work packages. Here are some tips in developing a Work Breakdown Structure that can express works
effectively:
o Always express Work Breakdown Structure activities at the lowest levels of granularity in verb form.
e Review the Work Breakdown Structure. Make sure all deliverables have been fully covered by the
works defined in the Work Breakdown Structure.
e Ensure that testing and training have been considered.
o Ensure that non-IT work packages are also included such as, documentatxon and review activities are
included in the structure.
o Ensure that other supportmg activities such as, product/service launch and implementation activities are
planned.
» Ensure that delivery approval cycles are considered.
Include project management deliverables on the project as well {e.g., productlon of Project Plan). Include any
deliverables that must be met or delivered by the customer or any external parties. Check the Work Breakdown
Structure against the project approach specified in Project Charter for any activities that needs to be included in
the Work Breakdown Structure. '
Different Forms of Work Breakdown Structure
There are three typical ways in structuring works with a Work Breakdown Structure (WBS) They include
phase-based structures, deliverable-based structures and responsibility-based structures.

Phase-based structures
Define and structure project activities based on the project phases.

Project Phases

-

Page 19



CH-407 Industrial Organization & Management Department of Metallurgical Engineering
e T O AR S

PILLAR 2—JISHU HOZEN (AUTONOMOUS MAINTENANCE)
This pillar is geared towards developing operators to be able to take care of small maintenance tasks, thus freeing
up the skilled maintenance people to spend time on more value-added activity and technical repairs. The operators
are responsible for upkeep of their equipment to prevent 1t from deteriorating,
1. Steps in JISHU HOZEN
Train the employees: Educate the employees about TPM its advantages, JH advantages and steps in JH. Educate
the employees about abnormalities in equipment.
2. Initial cleanup of machines
Supervisor and technician should discuss and set a date for implementing step 1.
e Arrange all items needed for cleaning. <
¢ On the arranged date, employees should clean the equlpment completely with the help of maintenance
department.
e Dust, stains, oils, and grease must be removed.
¢ Following are the things that must be taken care while cleaning. They are oil leakage, loose wires,
unfastened nits and bolts and worn-out parts.
o After cleaning up problems are categorized and suitably tagged. White tags are place where operators can
solve problems. Pink tag is placed where the aid of maintenance department is needed.
Contents of tag are transferred to a register.
Make note of area, which were inaccessible.
¢ Finally close the open parts of the machine and run the machine.

PILLAR 3—KAIZEN ‘Kai’ means change, and ‘Zen’ means good (for the better). Basically Kaizen is for small
improvements, but carried out on a continual basis and involve all people in the organization. Kaizen is opposite
to big spectacular innovations. Kaizen requires no or little investment. The principle behind is that “a very large
number of small improvements are more effective in an organizational environment than a few improvements of
large value.” This pillar is aimed at reducing losses in the workplace that affect our efficiencies. By using a
detailed and thorough procedure we eliminate losses in a systematic method using- various Kaizen tools. These
activities are not limited to production areas and can be implemented in administrative areas as well. Kaizen
Policy

e Practice concepts of zero losses in every sphere of activity.
Relentless pursuit to achieve cost reduction targets in all resources.
Relentless pursuit to improve overall plant equipment effectiveness.
Extensive use of PM analysis as a tool for eliminating losses.
Focus of easy handling of operators

16 Major Losses in a Organization

Lass Category

. Failure losses-—Breakdown loss

. Setup/adjustment. losses

. Cutting blade loss

Srart up loss

. Minor stoppage/Idiing loss

. Speed loss—operating at low speeds
. Defectirework loss

. Scheduled downtime toss ~

. Management loss Losses that impede equipment etficiency

L Y A

o

. Operating motion loss | Losses that impede buman work ¢fficiency

. Line organization loss

[}

o

. Logistic kiss

s

. Measurement and adjustment loss
. Encrgy loss

. Die, jig and tool breakage loss Losses that impede effective use of
16, Yiell loss production resources

=

2

A
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Deliverable-based structures .
Define and structure project activities based on the deliverables agreed to deliver.

Deliverables

b

Responsibility-based structure
Define and structure project activities based on the organization units that will work on the project.

Exercise:
Develop WBS for the designed project and include all main and sub levels likewise project bases WBS.
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Practical No. 6

Object: TOTAL QUALITY MANAGEMENT & ITS PILLARS

The TPM program closely resembles the popular Total Quality Management (TQM) program. Many of the tools
such as, employee empowerment, benchmarking, documentation, etc. used in TQM are used to implement and
optimize TPM. Following are the similarities between the two:

e Total commitment to the program by upper-level management is required in both programmes,

¢ Employees must be empowered to initiate corrective action.

¢ A long-range outlook must be accepted as TPM may take a year or more to implement and isan on-going
process. Changes in employee mind-set toward their job responsibilities must take place as well.

The differénces between TQM and TPM are summarized below

TPM
Equipment (Input and cause}
Employees participation and it is
hardware oriented
Elimination of losses and wastes.,

Caregory TOM
Quality (Output and effects)

Systematize the management.

Object
Mains of attaining

poal It is software oriented
Quality for PPM

Target

PILLAR 1-5S:

TPM starts with 5S. Problems cannot be clearly seen when the workplace is unorganized. Cleaning and

organizing the workplace helps the team to uncover problems. Making problems visible is the first step of
improvement. ‘

Jupanese term English translation Equi‘vézbmr ST term
- Seiti Organization | set

Seiton Tidiness Systematise

Seiso Cleaning Sweep

Seiketsu Standardisation Standardise

Shitsuke Disecipline Self-discipline
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Practical No. S
Object: Maintenance Management & Its Types

Introduction

Past and current maintenance practices in both the pnvate and Government sectors would imply that maintenance
is the actions associated with equipment repair after it is broken. The dictionary defines maintenance as “the work
of keeping something in proper condition, upkeep.” This would imply that maintenance should be actions taken to
prevent a device or component from failing or to repair normal equipment degradation experienced with the
operation of the device to keep it in prop‘er working order.

OBJECTIVES OF MAINTENANCE

Equipment’s are an important resource which is constantly used for adding value to products. So, it must be kept
at the best operating condition. Otherwise, there will be excessive downtime and interruption of production if it is
used in a mass production line. Poor working of equipment’s will lead to quality related problems. Hence, it is an
absolute necessity to maintain the equipments in good operating conditions with economical cost. Hence, we need
an integrated approach to minimize the cost of maintenance.

TYPES OF MAINTENANCE
The design life of most equipment requires periodic maintenance. Belts need adjustment, alignment needs to be
maintained, proper lubrication on rotating equipment is required, and so on. In some cases, certain components

need replacement, e.g., a wheel bearing on a motor vehicle, to ensure the main piece of

1. Breakdown Maintenance
2. Preventive Maintenance
3. Predictive Maintenance

Breakdown

Preventive

Predictive

| PROS | e Involves low-cost investment for
maintenance.

o Less staff is required

o Cost effective in many
capital-intensive
processes.

e . Flexibility.allows for
the adjustment of
maintenance

- periodicity.

e Increased component
life cycle. 4. Energy
savings.

¢ Reduced equipment or
process failure.

e Estimated 12% to 18%
cost savings over
reactive maintenance
program. ‘

e Increased component
operational life/availability.

e Allows for pre-emptive
corrective actions.

e Decrease in equipment or
process downtime.

' e Decrease in costs for parts

and labour.

Better product quality.
Improved worker and
environmental safety.
Improved worker moral.
Energy savings.
Estimated 8% to 12% cost
savings over preventive
maintenance program

CONS | e Increased cost due to unplanned

~ downtime of equipment.

e Increased labor cost, especially
if overtime is needed.

e  Cost involved with repair or
replacement of equipment.

e Possible secondary equipment
or process damage from
equipment failure.

e Inefticient use of staff
resources.

o - Catastrophic failures
still likely to occur.

e Labour intensive.

o Includes performance
of unneeded
maintenance.

e  Potential for incidental
damage to components
in conducting
unneeded
maintenance.

e Increased investment in
diagnostic equipment.

e Increased investment in staff
training.

e  Savings potential not readily
seen by management
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Basic Procurement Activities The following figure illustrates the flow of basic procurement activities:

R
Determination of Mhu {HaTRYIal OF SEIVRES e T
s’ | (TR D
R isition The fored or BlecHranic Iransmission used 10 inform
equis . e e Hising degartining thist tern or senvces are
Pescad for & Business purpcse
Purchase Order
Goods RW { Fhensterisd i reostent. Conuion and gusity are
Invaice RW ver i T iraoie i reneived froce vendos.
Invoice Verification/ BepiocHianion of the vtk sind PO is
Vendor Payment aixenplahid. Thevendor i paid,

A brief introduction of the procurement activities is given below:

Activities

[ It Is the logical subdivision where it'Is determined what material |
| or services are required, and which supplier can fulfill the H

' Determination of ! requirements.

requirement

| It is the phase in which the purchasing department is informed
. about the requirement of iterns or services. A requisition is an

. Creating purchase . ; earnal document.

. requisition

It Is the phase when an order is created from requisition and it

. i ! pHer.
' Creating purchase | is approved and assigned to a supplier.

order

! it is the phase In which the material is received by the company
' and its condition and quality are being inspected. In this phase,

" Goods receipt/ - an invoice is received from the vendor (seller).

 Invoice received

It is the phase in which the vendor (seller) is paid from the
i company and reconciliation of the invoice and PO is

Invoice . accomplished.

verification/Vendor
Payment

Exercise:

Develop a flow chart of SAP ERP for material issuance from Store to specific location with direct cost charge on
cost center.

THANK YOU
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Practical No. 7
Object: Introduction to SAP ERP & its Modules.

What are Enterprise Resource Planning (ERP) Systems?
e SAP mean System Applications and Products
e Incredibly large, extensive software packages used to manage a Company's business processes.
e Standard software packages that must be configured to meet the needs of a company

Database programs with the following functions:

e Input
e Storage/Retrieval
e Manipulation
e Output
WHY ERP /SAP

e Well integrated SAP has been implemented 9 out of 10 fortune 500 companies

It brings discipline in the Company

Has various authorization level, Complete tract record of entries, correction, and movements.
Drilldown facility for mapping the complete transaction

Brings overall efficiency in the organization

Best for growth of business

Brings various controlling mechanism

Export / import of data to external source

LOGIN SCREEN

Log on to the SAP ERP server. The SAP login screen
will prompt you for the User ID and the Password.
Provide a valid user ID and password and press enter.
The user id and password are provided by the system
administrator. The login screen appearsas follows:

TOOLBAR IN SAP

Given right is a brief description of the available
toolbars: :
¢ Menu Bar - Menu bar is the topline of the dialog
window in the SAP system.

e Standard Toolbar — This toolbar includes standard

The fnl!owlng screanshict shows the toolbars available on the SAP screen.

P e N

functions such as save, top of page, end of page, page L
up, page down, print, etc. e
e Title Bar - Title bar displays the name of the |: :EZ’;“;;"’;;.

application/business process you are currently in.

e Application Toolbar — Application-specific menu
options are available on this toolbar.

e Command Field - To start a business application
without navigating through menu transactions, some logical codes are assigned to the business processes.
Transaction codes are entered in the command field to start an application directly.
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PILLAR 4—PLANNED MAINTENANCE

It is aimed to have trouble free machines and equipment producing defect free products for total customer
satisfaction. This breaks maintenance down into 4 ‘families’ or groups, which was defined earlier.

e Preventive maintenance

e Breakdown maintenance

PILLAR 5—QUALITY MAINTENANCE
It is aimed towards customer delight through highest quality through defect free manufactunng Focus is on
eliminating non-conformances in a systematic manner, much like Focused Improvement. We gain understanding
of what parts of the equipment affect product quality and begin to eliminate current quality concerns, then move
to potential quality concerns. Transition is from reactive to proactive{(Quality Control to Quality Assurance). QM
activities is to set equipment conditions that preclude quality defects, based on the basic concept of maintaining
perfect equipment to maintain perfect quality of products. The conditions are checked and measure in time series
to very that measure values are within standard values to prevent defects. The transition of measured values is
watched to predict possibilities of defects occurring and to take counter measures beforehand. Policy

e Defect free conditions and control of equipment’s.
QM activities to support quality assurance.
Focus of prevention of defects at source.
Focus on poka-yoke (fool proof system).
In-line detection and segregation of defects.
Effective implementation of operator quality assurance.

® o o & o

Exercise:
Assume any machine or equipment and create kaizen report on the idea that small, ongoing positive changes can
reap significant improvements. For reference, please review below table.-

KAIZEN ACTION SHEET

Manager Or Supervisor

Date 02108100 ltem#: 35
Person doing. this sheet

Area O process name

PeterF Aszembly Line 1 , JohnH,

Problem description:

ft:is time consuming toupdate the
chart because the pencilis vever
there. We lose time looking for the
pencilor we sometimes donot
updatethe chart because we do
1ot have the time

Actions to be taken:

Hang a pencil next Lo bhe
chart: (attached to the
o)

- Nomaorse wasted time.
looking for pencil and
atwaya updated charte

Expected results/benefit:

Output

Before improvement (draw picture):

Missing data

0

13-

After improvement {draw picture}:

Frequency of missing data

Outputs measured / to be measured to determine impact of changes:
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Concept of Reliability:

Reliability is the probability of survival under a given operating environment. For example, the time between
consecutive failures of a refrigerator where continuous working is required is a measure of its reliability. If this
time is more, the product is said to have high reliability. In a textile mill, generally the light is maintained at a
minimum specified level. To achieve this, let us assume that there are 100 bulbs in use and the guaranteed life
time of these bulbs is 5000 hours. If we collect statistics about the number of bulbs survived till 5000 hours, we
can compute the reliability of the bulbs. In this case,

Number of bulbs survived till the specified time limit
MNumber of bulbs used

If the number of bulbs survived till 5000 hours is 80, then we can say that the reliability is 0.8 (i.e., 80/100) The
reliability of railway signaling system, aircraft, and power plant are some of the interesting examples for
demonstrating the reliability concept. In these cases, a failure will lead to. heavy penalty. the individual
component’s reliability affects the reliability of the product. Hence, enough attention must be given at the design,
stage such that the product’s reliability is maximized. The cost of maintenance is also to be considered along with
the reliability while improving it. The general failure pattern of any product is given in Fig. 8.1. This is called
bath-tub curve. In Fig. 8.1, there will be large number of failures in the early period. This is mainly due to

nonalignment while shipping the product, or misfit while manufacturing (assembling), or very high initial friction
between moving parts, etc :

Reliability = Failurerate =

[ Ul lifg iy i )
3 -
&
®
@ N e
ety Sl R0 1R b N Al Tailiras et

Tiene : g

Fig. 8.1 Product failure rate

Product failure rate Reliability Improvement The reliability of a system/product depends on many factors. So, we
should concentrate at the grassroot level to improve product’s reliability. Some of the ways of improving systems
reliability are listed below: :
o Improved design of components
Simplification of product structure
Usage of better production equipment
Better quality standards
Better testing standards
Enough standby units
e Usage of preventive maintenance, if necessary, at appropriate time.
Maintenance Sheet

Exercise:
Develop Maintenance log sheet for gear box maintenance for shaft failure.

A O S S
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